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Warranty and Liability

Warranty and Liability

Note

The application examples are not binding and do not claim to be complete
regarding configuration, equipment and any eventuality. The application
examples do not represent customer-specific solutions. They are only intended
to provide support for typical applications. You are responsible for ensuring that
the described products are used correctly. These application examples do not
relieve you of the responsibility to use sound practices in application, installation,
operation and maintenance. When using these Application Examples, you
recognize that we cannot be made liable for any damage/claims beyond the
liability clause described. We reserve the right to make changes to these
Application Examples at any time without prior notice. If there are any deviations
between the recommendations provided in this application example and other
Siemens publications — e.g. Catalogs — the contents of the other documents
have priority.

We accept no liability for information contained in this document.

Any claims against us — based on whatever legal reason — resulting from the use of
the examples, information, programs, engineering and performance data etc.,
described in this Application Example shall be excluded. Such an exclusion shall
not apply in the case of mandatory liability, e.g. under the German Product Liability
Act (“Produkthaftungsgesetz”), in case of intent, gross negligence, or injury of life,
body or health, guarantee for the quality of a product, fraudulent concealment of a
deficiency or breach of a condition which goes to the root of the contract
(“wesentliche Vertragspflichten”). However, claims arising from a breach of a
condition which goes to the root of the contract shall be limited to the foreseeable
damage which is intrinsic to the contract, unless caused by intent or gross
negligence or based on mandatory liability for injury of life, body or health. The
above provisions do not imply a change in the burden of proof to your detriment.

It is not permissible to transfer or copy these Application Examples or excerpts
thereof without express authorization from Siemens Industry Sector.
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1 Automation Task

1 Automation Task

1.1 Overview

Introduction

In order to diagnose communication connections which are configured for data
exchange via an Industrial Ethernet communication module (CP) of S7-300, the
NCM S7 diagnostic is normally used. The NCM S7 diagnostic tool is integrated in
STEP 7 and provides a clear overview of the status of the configured
communication connections. The disadvantage here is that the status information
of the NCM S7 diagnostic cannot be visualized on an operator panel or a control
system.

In this application example we show you how the status of the communication
connections in the user program of the CPU can be determined and visualized on
an operator panel with little configuration and programming workload.

Overview of the automation task

The figure below provides an overview of the automation task.

Figure 1-1
Diagnostic of the connections
S7 Station A HMI Multi Panel
CP
Industrial Ethernet
n connections via CP I~

—
S~ ~a —~ Partner stations

S7 Station B S7 Station C  S7 Station D

Description of the automation task

Visualizing the status of the configured communication connection of the Industrial
Ethernet CP on an HMI Multi Panel using WinCC flexible requires:

e analyzing all communication connections of the Industrial Ethernet CP and
e storing them for the HMI Multi Panel in the user program of the CPU.

Connection Diagnostics CPx43-1
V1.0, Entry ID: 42453077 7
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2 Automation Solution

2 Automation Solution

21 Overview of the overall solution

Schematic layout
The following figure displays the most important components of the solution:

Figure 2-1
S7-300 Station A S7-300 Station B
El —”2 3 n connections ED » Part_ner
ol° station
EAR
SCALANCE X208
FB170 “SR_DIAG* =T
FB171 “S7_DIAG* 2 E._
SIMATIC Field PG N .ﬁ% MP277 8 Touch
L ~
0

N

A

Setup

The S7-300 stations A and B are connected at the Industrial Ethernet network via
communication processors (CP343-1). The data exchange between the S7-300
stations A and B occurs via several, different communication connections with
standard functions.

The function blocks FB170 “SR_DIAG” and FB171 “S7_DIAG” supplied with this
application are implemented in the user program of S7-300 station A. These
compact function blocks determine the status information of the communication
connections, which have been configured on S7-300 station A for the Industrial
Ethernet CP343-1.

Table 2-1 gives an overview of the communication connections and standard
functions configured and programmed on S7-300 station A for the data exchange
via CP343-1.

Connection Diagnostics CPx43-1
V1.0, Entry ID: 42453077 8
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Table 2-1
Connection start ID | Connection type Service Standard functions
active 1 S7 connection PUT / GET FB14 “GET” and
FB15 “PUT”
active 2 S7 connection PUT / GET FB14 “GET” and
FB15 “PUT”
active 3 S7 connection PUT / GET FB14 “GET” and
FB15 “PUT”
passive 4 S7 connection BSEND / FB12 “BSEND” and
BRECV FB15 “BRECV”
passive 1 ISO-on-TCP SEND/ FC5 “AG_SEND” and
connection RECEIVE FC6 “AG_RECV”
passive 2 ISO-on-TCP SEND/ FC5 “AG_SEND” und
connection RECEIVE FC6 “AG_RECV”
passive 3 TCP connection SEND/ FC5 “AG_SEND” and
RECEIVE FC6 “AG_RECV”
passive 4 TCP connection SEND/ FC5 “AG_SEND” und
RECEIVE FC6 “AG_RECV”
passive 5 ISO-on-TCP FETCH -
connection
passive 6 ISO-on-TCP WRITE -
connection
- 7 TCP connection FTP FB40 “FTP_CMD”
- 8 UDP connection SEND / FC5 “AG_SEND” and
(multicast) RECEIVE FC6 “AG_RECV”

Connection Diagnostics CPx43-1
V1.0, Entry ID: 42453077 9
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2 Automation Solution

Table 2-2 shows an overview of the communication connections which can be diagnosed with the supplied function blocks FB170 “SR_DIAG” and

FB171 “S7_DIAG".

The determined status information is structured stored in the instance data block of FB170 and FB171 and displayed on the HMI Multi Panel in WinCC

flexible.

For diagnosing the communication connections configured on an S7-400 station for the Industrial Ethernet CP443-1, the FB270 “SR_DIAG_400" is

available to you.

Table 2-2
Function block Connection type Service Interface
CP343-1 CP443-1 | Integrated PN interface
FB171 “S7_DIAG” S7 connection PUT / GET X - -
FB171 “S7_DIAG” S7 connection BSEND / BRECV X - -
FB171 “S7_DIAG” S7 connection USEND / URECV X - -
FB170 “SR_DIAG” TCP connection AG_SEND / AG_RECV X - -
FB170 “SR_DIAG” TCP connection FETCH / WRITE X - -
FB170 “SR_DIAG” ISO transport connection AG_SEND / AG_RECV X - -
FB170 “SR_DIAG” ISO transport connection FETCH /WRITE X - -
FB170 “SR_DIAG” ISO-on-TCP connection AG_SEND / AG_RECV X - -
FB170 “SR_DIAG” ISO-on-TCP connection FETCH / WRITE X - -
FB170 “SR_DIAG” UDP connection (including multicast and broadcast) AG_SEND / AG_RECV X - -
FB170 “SR_DIAG” TCP connection FTP X - -

FB270 “SR_DIAG_400"

TCP connection

AG_SEND / AG_RECV

FB270 “SR_DIAG_400"

TCP connection

FETCH/WRITE

FB270 “SR_DIAG_400"

ISO transport connection

AG_SEND / AG_RECV

FB270 “SR_DIAG_400"

ISO transport connection

FETCH /WRITE

FB270 “SR_DIAG_400"

ISO-on-TCP connection

AG_SEND / AG_RECV

FB270 “SR_DIAG_400"

ISO-on-TCP connection

FETCH /WRITE

FB270 “SR_DIAG_400”

UDP connection (including multicast and broadcast)

AG_SEND / AG_RECV

FB270 “SR_DIAG_400”

TCP connection

FTP

XXX X[ X[X]|X]|X

Connection Diagnostics CPx43-1
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2 Automation Solution

Note In chapter “Performance Data” of the manual of the respective Industrial Ethernet
CP (CP343-1 or CP443-1) you find information on the max. number of possible
connections.

The HMI Multi Panel is connected to the same Industrial Ethernet network as the
S7-300 stations. Via S7 connection it accesses the CPU of S7-300 station A, to
read the structured status information of the communication connection from the
instance data block of FB170 “SR_DIAG” and FB171 “S7_DIAG”. The read status
information is displayed on the HMI Multi Panel in WinCC flexible Runtime.

Topics not covered by this application
This application does not contain a description

o of the standard functions for the Industrial Ethernet CP343-1 or CP443-1 to
exchange data via communication connections.

e for configuring WinCC flexible
o for operating the HMI Multi Panel
Basic knowledge of these topics is required.

Manuals are available to you on the internet as downloads providing you with
detailed information on the standard functions for the data exchange via Industrial
Ethernet CP (see \3\ and \16\).

The manuals of WinCC flexible 2008 are available to you as downloads on the
internet (see \10\, \11\, \12\ and \17\).

The manual on HMI MP277 8” Touch is available to you as download on the
internet (see \1\).
Required knowledge

Basic knowledge on using WinCC flexible, HMI Multi Panels and communication
mechanisms of the Industrial Ethernet CPs is assumed.

Connection Diagnostics CPx43-1
V1.0, Entry ID: 42453077 11
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2 Automation Solution

2.2

Description of the core functionality

Process sequence of main functionality

Table 2-3
No. Action Note
1. In the CPU the status information of all CPU of S7-300 station A
S7 and SEND/RECEIVE connections of
the Industrial Ethernet CPs are read
cyclically by FB170 “SR_DIAG” and
FB171 “S7_DIAG".
2. The status information is structured CPU of S7-300 station A
stored in the instance data blocks of
FB170 and FB171.
3. Structured status information is read HMI Multi Panel
from the instance data blocks of FB170
and FB171 and displayed in several
pictures in WinCC flexible Runtime.
4. e  Start screen SIEMENS
Connection diagnostic for CPx43-1
_— =‘|
'SEND/RECEIVE connection
5. e  Overview of connections SIEMENS
/ieRvE'CElVE connection
1 S T D M M ||
I N e e M e
Connection Diagnostics CPx43-1

V1.0, Entry ID: 42453077
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No. Action Note
6. Details view of a connection SIEMENS
The details view contains the user
|nformat_|on on connection status, o
connection type and connection
number of a particular, selected momeome mecior ]
connection.
‘connection status
Note:

Information on data transmission, e.g.
number of sent and received data, are
not displayed in the details view.

Advantages of this solution

e The user has a reduced configuration and programming workload due to
compact function blocks.

e The user can quickly implement the prepared pictures of the visualization in his
own HMI user interface.

e No additional tool / SIMATIC field PG is required for the connection diagnostic.

Connection Diagnostics CPx43-1
V1.0, Entry ID: 42453077 13
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2 Automation Solution

2.3 Used hardware and software components
The application has been set up with the following components:

Hardware components

Table 2-4
Component Qty. MLFB / order number Note
CPU 315-2DP 1 6ES7315-2AG10-0AB0 V2.6
CP343-1 Advanced 1 6GK7343-1GX30-0XEO V1.0
CPU 319-3PN/DP 1 6ES7 318-3EL00-0ABO V2.8
CP343-1 Lean 1 6GK7 343-1CX10-0XEO V2.1
MP277 8” Touch 1 6AV6643-0CB01-1AX1
Standard software components
Table 2-5
Component Qty. MLFB / order number Note
STEP 7 V5.4 SP5 1 6ES7810-4CC08-0YAS or higher
\éV;qCC flexible 2008 1 6AV6612-0AA51-3CA5 or higher

Example files and projects
The following list contains all files and projects used in this example.

Table 2-6
Component Note
42453077 _diagnostic_v10.zip This zip file contains the STEP 7
project
42453077_ConnectionDiagnostic_v10_e.pdf This document

Connection Diagnostics CPx43-1
V1.0, Entry ID: 42453077 14
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2 Automation Solution

Performance data

Supported S7-300 Industrial Ethernet CPs

Table 2-7 contains an overview of the S7-300 Industrial Ethernet CPs which
support FC10 “AG_CNTRL” and hence also FB170 “SR_DIAG”.

Table 2-7
Component MLFB Firmware
CP343-1 Lean 6ES7343-1CX10-0XEQ as of V2.1
CP343-1 6ES7343-1EX20-0XEO as of 1.3.9
CP343-1 6ES7343-1EX21-0XEOQ as of 1.0.17
CP343-1 6ES7343-1EX30-0XEO as of 2.0.16
CP343-11T 6ES7343-1GX20-0XEO asof1.1.4
CP343-1 Advanced 6ES7343-1GX21-0XEOQ as of 1.0.24
CP343-1 Advanced 6ES7343-1GX30-0XEO as of 1.0.23

Supported S7-400 Industrial Ethernet CPs

Table 2-8 contains an overview of the S7-400 Industrial Ethernet CPs which
support FC10 “AG_CNTRL” and hence also FB270 “SR_DIAG_400".

Table 2-8
Component MLFB Firmware
CP443-1 6ES7443-1EX20-0XEOQ as of 1.0.26
CP443-1 Advanced 6ES7443-1EX41-0XEQ as of 1.0.24

CP443-1 Advanced

6ES7443-1GX20-0XEOQ

as of 2.0

Function blocks FB170, FB270 and FB171

All communication connections listed in Table 2-2 can be diagnosed with function
blocks FB170 “SR_DIAG”, FB171 “S7_DIAG” and FB270 “SR_DIAG_400".

The call of FC10 “AG_CNTRL” from the SIMATIC NET CP -> CP 300 -
Blocks library has been implemented in FB170 “SR_DIAG”, i.e. the

communication connections of the S7-300 Industrial Ethernet CPs listed in Table
2-7 can be diagnosed with FB170.

The call of FC10 “AG_CNTRL” from the SIMATIC NET CP - CP 400 ->
Blocks library has been implemented in FB270 “SR_DIAG_400”, i.e. the
communication connections of the S7-400 Industrial Ethernet CPs listed in Table 2-
8 can be diagnosed with FB270.

Using FB171 “S7_DIAG” only the S7 connections of CP343-1 can be diagnosed.
The S7 connections of CP443-1 or the integrated PN interface of a CPU are not

diagnosed (see Table 2-2).

The status information of max 64 connections is stored in the instance data blocks

of FB170, FB270 and FB171.

Connection Diagnostics CPx43-1
V1.0, Entry ID: 42453077
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2 Automation Solution

Functions STOP and START

Table 2-9 contains an overview of the Industrial Ethernet CPs, on which the
commands CMD 6 “CN_DISCON” and CMD 7 “CN_STARTCON” of FC10
“AG_CNTRL” are supported and on which therefore the functions STOP and

START are available.

Table 2-9
Component MLFB Firmware
CP343-1 Advanced B6ES7343-1GX30-0XEOQ as of V1.0.23
CP443-1 Advanced 6ES7443-1GX20-0XEOQ as of V2.0
CP443-1 6ES7443-1EX20-0XEQ as of V1.0.26

Connection Diagnostics CPx43-1
V1.0, Entry ID: 42453077
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3 2BFunction Mechanisms of this Application

3 Function Mechanisms of this Application
General overview
Figure 3-1
S§7-300 Station A S$7-300 Station B
] ) : S7 connection ] a > Partner
= % o SEND/RECEIVE connection [ station
Ly
SCALANCE X208
FB170 “SR_DIAG" —
FB171 “S7_DIAG* JE -
SIMATIC Field PG oo MP277 8 Touch
[ﬁ% WinCC flexible
Runtime

STEP 7
WinCC flexible

Between the CP343-1 in S7-300 stations A and B there are several S7 connections
and SEND/RECEIVE connections via which data exchange is handled. Function
blocks FB170 “SR_DIAG” and FB171 “S7_DIAG” are used to determine the status
information of the configured connections and save it in the instance data block.

Program overview

Figure 3-2
S7-300 Station A MP277 8“ Touch
OB1 IWinCC flexible Runtime

DB170 Status information
SEND/RECEIVE connection
FB170 '

FC10 J
“AG_CNTRL"

@ Status information
S7 connection
FB171
FC62 J
“C_CNTRL"

Function blocks FB170 “SR_DIAG” and FB171 “S7_DIAG” are cyclically called in
the user program of S7-300 station A. They internally call the functions FC10
“AG_CNTRL” or FC62 “C_CNTRL". This way status information, e.g. connection
type and connection status, is determined, and structured stored in the instance
data blocks for visualization. The saved status information is transferred to multi
panel MP2Z7 8” Touch and displayed in WinCC flexible Runtime.

v

Connection Diagnostics CPx43-1
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3 2BFunction Mechanisms of this Application

User program of S7-300 station A

The user program of S7-300 station A consists of the following blocks:

Table 3-1

Block

Symbolic name

Description

OB1

CYCL_EXC

In OB1 the function blocks FB170 and FB171
including the appropriate instance data blocks
DB170 and DB171 are called cyclically.

FB170

SR_DIAG

Internally FB170 calls the function block FC10
“AG_CNTRL” with various commands (CMD).
Amongst other things, the status information
of the SEND/RECEIVE connections is
determined this way and can be prepared for
visualization.

FB171

S7_DIAG

Internally FB171 calls the function block FC62
“C_CNTRL".

Status information of the S7 connections is
determined this way and can be prepared for
visualization.

DB170

iDB_SR_DIAG

In instance data block DB170 the status
information of the SEND/RECEIVE
connections is saved.

DB171

iDB_S7_DIAG

In instance data block DB171 the status
information of the S7 connections is saved.

uDT170

UDT_170

The user-defined data type UDT170 has been
implemented in instance data block DB170.
Here the status information of all
SEND/RECEIVE connections is saved
(connection numbers 1 to 64).

FB100

SR_COMM

Internally FB100 calls up the communication
function for the data exchange via the
configured SEND/RECEIVE connections.

FB200

S7_COMM

Internally FB200 calls up the communication
function for the data exchange via the
configured S7 connections.

DB100

iDB_SR_COMM

Instance data block of FB100

DB200

iDB_S7_COMM

Instance data block of FB200

DB101

SR_SendData

In DB101 the send data for the data exchange
via the configured SEND/RECEIVE
connections are saved..

DB102

SR_ReceiveData

DB102 contains the data, which are received
via the configured SEND/RECEIVE
connections.

DB201

S7_SendData

In DB201 the send data for the data exchange
via the configured S7 connections are saved.

DB202

SR_ReceiveData

DB202 contains the data, which are received
via the configured S7 connections.

Connection Diagnostics CPx43-1
V1.0, Entry ID: 42453077
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3 2BFunction Mechanisms of this Application

3.1 Diagnosing the SEND/RECEIVE connections with
FB170 “SR_DIAG”

Function block FB170 “SR_DIAG” is used for diagnosing the SEND/RECEIVE
connections of the CP343-1. Figure 3-3 illustrates the call of FB170 in the user
program of the CPU. FB170 is called cyclically in OB1.

3.11 Input and output parameters of FB170 “SR_DIAG”

FB170 “SR_DIAG” has an input parameter “LADDR”. At the input parameter
“LADDR” you enter the module start address of the Industrial Ethernet CP343-1.
The module start address is available in STEP 7 in the hardware configuration (see
chapter 6.4.2 “Loading the communication connections”).

Figure 3-3

DB170

FB170
LADDR

WORD

Connection Diagnostics CPx43-1
V1.0, Entry ID: 42453077 19
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3 2BFunction Mechanisms of this Application

3.1.2 Sequence of FB170 “SR_DIAG”

Overview

Figure 3-4 illustrates the sequence of FB170 “SR_DIAG”.
Figure 3-4

| ID = connection number = 0 fe—

- i

call FC10 “AG-CNTRL" with CMD 0

| call FC10 “AG-CNTRL" with CMD 1

]

Determining the connection type and status for dispaly in the
connection overview

Determining the maximum number of configurable connections

HMI_CONN_RESET = TRUE

\QTno

| call FC10 “AG_CNTRL" with CMD 2 |

HMI_CONN_STOP = TRUE le—

\Qno

call FC10 “AG_CNTRL" with CMD 6 |

\Qno

call FC10 “AG_CNTRL" with CMD 7

¥
« Error evaluation
» Save the maximum number of configurable connections in the
instance DB
* Prepare data for display in the details view

v
| HMI_CONN_START = TRUE |—

FB170 “SR_DIAG” encapsulates the call of FC10 “AG_CNTRL” from the
“SIMATIC_NET_CP > CP 300 - Blocks” library with various commands (CMD)
for determining:

e the connection status and connection type of SEND/RECEIVE connections

¢ the number of maximum configurable SEND/RECEIVE connections, as well as
for realizing various functions e.g.:

o Resetting the connection (RESET)
e Disconnecting (START)
e Establishing the connection (STOP)

Connection Diagnostics CPx43-1
V1.0, Entry ID: 42453077 20
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3 2BFunction Mechanisms of this Application

Input and output parameters of FB10 “AG_CNTRL”
FC10 “AG_CNTRL” has the following input and output parameters.

Figure 3-5
FC10,,AG_CNTRL*
BOOL- ACT DONE BOOL
INT- ID ERROR BOOL
WORD———— LADDR STATUS WORD
INT. CMD RESULT1 DWORD
RESULT2 ——DWORD
Table 3-2
Input parameters Data type Description

ACT BOOL 1: function call
0: no function call and the block is quit
immediately

ID INT Connection number
The connection number is contained in
the configuration.

LADDR WORD Module start address
The module start address of the CP is
contained in the hardware
configuration.

CMD INT Command at FC10 “AG_CNTRL”
Table 3-4 gives an overview of all
possible commands.

Table 3-3
Output parameters Data type Description

DONE BOOL 1: job executed
0: job still processed or not triggered
yet
At DONE=1 the output parameters
RESULT1 and RESULT2 can be
evaluated.

ERROR BOOL Error code
1: error
0: no error

STATUS WORD Status code

RESULT1 DWORD Information returned according to
command sent to FC10 “AG_CNTRL”

RESULT2 DWORD Can only be evaluated for S7-400.
Part 2 of information according to the
command sent to FC10 “AG_CNTRL”

Connection Diagnostics CPx43-1
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Commands of the FC10 “AG_CNTRL”

The following commands can be configured at FC10 “AG_CNTRL” and be
evaluated by the Industrial Ethernet CP:

Table 3-4
CMD Description

0 NOP - no operation
The block is processed without job for the CP.

1 CN_STATUS - connection status
This command provides the status of the connection selected with
ID.

2 CN_RESET - connection reset
This command resets the connection selected with ID

3 CN_STATUS_ALL - all connections status
This command provides the connection status of all connections.

4 CN_RESET_ALL - all connections reset
This command resets all connections.

5 CN_CLEAR_RESET - Resetting the reset identifier
This command resets the reset identifier of the connection selected
with ID. This command is only required in special cases.

6 CN_DISCON - connection disconnect
This command disconnects the connection selected with ID and
LADDR (stop connection).

7 CN_STARTCON - start connection
This command establishes a connection selected with ID and
LADDR and previously disconnected with CMD 6 (CN_DISCON).

Determining the connection type and status for the display in WinCC flexible

For connection number = 0 the FC10 “AG_CNTRL” is called with the input
parameter CMD=0.

For each further connection number > 0 the FC10 “AG_CNTRL” is called with the
input parameter CMD=1 and the job result of the output parameter RESULT1 and
RESULT2 is evaluated.

The job result of the output parameter RESULT1 and RESULT2, which contains
information on connection type and status, is evaluated and filed in the instance
data block DB170 in a structure (see Table 3-7).

For the command CMD=1 the job result of the output parameters RESULT1 and
RESULT?2 is structured as follows:

Table 3-5
Parameters Hex value/ Bit Description
area
RESULT1 0000 000*(hex) | Bit 0-3: Display for the send direction

Bit 0 Connection type
0: no send or receive connection

1: connection reserved for send and
receive jobs

Bit 1 Status of current job

0: no send job currently processed
1: send job currently processed

- not relevant
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Parameters Hex value/ Bit Description
area
Bit 2+3 previous job
- not relevant
RESULT1 0000 00*0(hex) | Bit 4-7: display for the receive direction
Bit 4 Connection type

0: no send or receive connection

1: connection reserved for send and
receive jobs

Bit 5 Status of current job

0: no receive job currently processed
1: receive job currently processed

- not relevant

Bit 6+7 Previous job
- not relevant

RESULT1 0000 0*00(hex) | Bit 8-11: display for FETCH / WRITE

Bit 8 Connection type
0: no FETCH connection
1: connection reserved for FETCH jobs

Bit 9 Connection type
0: no WRITE connection
1: connection reserved for WRITE jobs

Bit 10 Job status (FETCH / WRITE)

0: job status OK
1: job status NOT OK

- not relevant

Bit 11 Status FETCH / WRITE job

0: there is no job
1: a job from the LAN is currently

processed
- not relevant
RESULT1 0000 *000(hex) | Bit 12-15: general CP information
Bit 12+13 Information on the connection status

00: connection cancelled

01: connecting process running
10: disconnecting process running
11: connection established

Bit 14 CP information (STOP/RUN)
- not relevant
Bit 15 Reset identification

- nicht relevant

RESULT1 ***% 0000(hex) Bit 16-31 reserved for later expansion

RESULT2 0000 0000(hex) reserved for later expansion
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Determining the maximum number of configurable SEND/RECEIVE connections

The maximum number of configurable SEND/RECEIVE connections is determined
automatically. When calling the FC10 “AG_CNTRL” with the input parameter
CMD=1 the value of the output parameter STATUS is evaluated.

If the value of the output parameter STATUS provides the value 8186H, then the
maximum number of configurable SEND/RECEIVE connections is determined via
the connection number specified at the input parameter ID and stored in the
instance data block DB170 (see Table 3-6).

3.1.3 HMI interface

The data required for the visualization is stored in the instance data block DB170 in
the following tags (see Table 3-6). These tags are integrated into WinCC flexible
and form the HMI interface. This enables displaying the data stored in the tags at
the HMI Multi Panel or the tags can be set by the HMI Panel.

Table 3-6
Address Tag Data type Description
DB170
32.0 CONN Array [0..65] Status information of all
of UDT 170 configurable SEND/RECEIVE

connections

296.0 MAX_CONNECTION Int Maximum number of
configurable SEND/RECEIVE
connections

298.0 HMI_CONN Int Connection number

300.0 HMI_Detail Bool Details view
activated/deactivated

300.1 HMI_CONN_STOP Bool Stop SEND/RECEIVE
connection

300.2 HMI_CONN_START Bool Start SEND/RECEIVE
connection

300.3 HMI_CONN_RESET Bool Reset SEND/RECEIVE
connection

301.0 HMI_CONN_TYPE Byte Connection type

302.0 HMI_CONN_STATUS Byte Connection status

303.0 HMI_CONN_RESERVE1 | Byte Reserve

304.0 HMI_CONN_RESERVE2 | Byte Reserve

306.0 HMI_CMD_STATUS Int Job status

Connection Diagnostics CPx43-1
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Setup of UDT 170

The relevant status information of all configured SEND/RECEIVE connections, e.g.
connection type and connection status, are stored in the instance data block
DB170 in CONN array of data type UDT 170.

The user-defined data type UDT170 is structured as follows:

Table 3-7
Tag Data Value (bin) | Value Description
type (dec)

CONN_TYPE Byte 0000 0000 0 connection type is unknown
0000 0001 1 SEND/RECEIVE connection
0000 0010 2 FETCH connection
0000 0100 4 WRITE connection
0000 1000 8 undefined connection type

CONN_STATUS Byte 0000 0000 0 connection is disconnected
0000 0001 1 establishment is in process
0000 0010 2 disconnection is in process
0000 0011 3 Connection is established

RESERVE_1 Byte 0000 0000 0 Reserve

RESERVE_2 Byte 0000 0000 0 Reserve

The status information stored in the CONN array is implemented in WinCC flexible
in the connection overview.

Details view

The HMI_Detail tag of data type Bool is controlled by the HMI Multi Panel. If the
HMI_Detail tag has the value “true”, then the following status information of a
selected SEND/RECEIVE connection is updated for the display in the details view
and stored in the instance data block DB170.

Table 3-8
Tag Data type Status information
HMI_CONN Int connection number
HMI_CONN_STATUS Byte connection status
HMI_CONN_TYPE Byte connection type
HMI_CMD_STATUS Int error code

Connection status

In HMI_CONN_STATUS tag of data type Byte the connection status of the
selected SEND/RECEIVE connection is stored for the display in the details view.

Table 3-9 shows the value range of the HMI_CONN_STATUS tag.

Table 3-9
Value (bin) Value (dec) Connection status
0000 0000 0 connection is disconnected
0000 0001 1 establishment is in process
0000 0010 2 disconnection is in process
0000 0011 3 connection is established
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Connection type

In HMI_CONN_TYPE tag of data type Byte the connection type of the selected
SEND/RECEIVE connection is stored for the display in the details view.

Table 3-10 shows the value range of the HMI_CONN_STATUS tag.

Table 3-10
Value (bin) Value (dec) Connection type
0000 0000 0 connection type is unknown
0000 0001 1 SEND/RECEIVE connection
0000 0010 2 FETCH connection
0000 0100 4 WRITE connection
0000 1000 8 undefined connection type

Connection number

In HMI_CONN tag of data type Integer the connection number is stored. The tag is
set via the HMI Multi Panel in connection overview of the SEND/RECEIVE
connection.

If the value of the HMI_CONN tag is larger than the determined maximum number
of configurable SEND/RECEIVE connections, the HMI_CONN tag is set to value
1(dec).

If the value of the HMI_CONN tag is smaller than 1 (dec), the HMI_CONN tag is

set to the determined maximum number of configurable SEND/RECEIVE
connections.

Job status

The HMI_CMD_STATUS tag data type integer is implemented in the details view of
SEND/RECEIVE connection. It displays the job status of the functions STOP,
START und RESET.

Table 3-11 shows an overview of the job status of functions STOP, START and
RESET and the value of the HMI_CMD_STATUS tag.

Table 3-11

Value of the Job status
HMI_CMD_STATUS (dec) tag

request is completed successfully

function not available

command isn’t allowed

O (N[~ |O

general failure

Connection Diagnostics CPx43-1
V1.0, Entry ID: 42453077 26



3 2BFunction Mechanisms of this Application

Copyright © Siemens AG 2010 All rights reserved

314 Functions

The tags of the instance data block DB170 listed in Table 3-12 are implemented in
the details view of the SEND/RECEIVE connection diagnostic and can therefore be
controlled via the HMI Multi Panel to realize different functions.

If the tags are controlled to value “true” a job for resetting, stopping or starting a
certain, selected SEND/RECEIVE connection is initiated.

Table 3-12
Tag Data type Function

HMI_CONN_STOP Bool 0: no function

1: STOP (stop the connection)
HMI_CONN_START Bool 0 = no function

1 = START (start the connection)
HMI_CONN_RESET Bool 0 = no function

1 = RESET (reset the connection)

Reset the connection (RESET)

If the HMI_CONN_RESET tag of the type BOOL has the value “true”, then the
FC10 “AG_CNTRL” is called with input parameter CMD=2. This resets the
connection specified at the input parameter ID via the connection number.

If the job was completed successfully or with error, then the HMI_CONN_RESET
tag is reset to value “false”.

If the job was completed with error, than there is an additional error evaluation (see
chapter 3.1.5 “Error evaluation”).

Stop the connection (STOP)

If the HMI_CONN_STOP tag of the type BOOL has the value “true”, then the FC10
“AG_CNTRL” is called with input parameter CMD=6. This stops the connection
specified at the input parameter ID via the connection number.

If the job was completed successfully or with error, then the HMI_CONN_STOP tag
is reset to value “false”.

If the job was completed with error, than there is an additional error evaluation (see
chapter 3.1.5 “Error evaluation”).

Start the connection (START)

If the HMI_CONN_START tag of the type BOOL has the value “true”, then the
FC10 “AG_CNTRL” is called with input parameter CMD=7. This starts the
connection specified at the input parameter ID via the connection number and
which was previously stopped with CMD=6.

If the job was completed successfully or with error, then the HMI_CONN_START
tag is reset to value “false”.

If the job was completed with error, than there is an additional error evaluation (see
chapter 3.1.5 “Error evaluation”).
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3.1.5 Error evaluation

If the start, stop or reset job of the FC10 “AG_CNTRL" is transferred successfully to
the Industrial Ethernet CP then the HMI_CMD_STATUS tag is set to value 0 (dec).

If one of the jobs of FC10 “AG_CNTRL” was not successfully transferred to the
Industrial Ethernet CP and completed with error, then the value of the output
parameter STATUS is evaluated.

For the display in the details view a value is assigned to the HMI_CMD_STATUS
tag according to the value at the output parameter STATUS.

Table 3-13
Value at output parameter Value of the Job status
STATUS (hex) HMI_CMD_STATUS (dec)
tag
0000 0 request is completed
successfully
80B0 1 function not available
8189
8187 2 command isn’t allowed
8xxx 9 general failure
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3 2BFunction Mechanisms of this Application

3.2 Diagnosing SEND/RECEIVE connections with the
FB270 “SR_DIAG_400”

Function block FB270 “SR_DIAG” is used for diagnosing the SEND/RECEIVE
connections of the CP443-1. Figure 3-6 illustrates the call of FB270 in the user
program of the CPU. FB270 is called cyclically in OB1.

3.21 Input and output parameters of FB270 “SR_DIAG_400”

Analog to FB170 “SR_DIAG”, the FB270 “SR_DIAG_400" has the input parameter
“LADDR”. At the input parameter “LADDR” you enter the module start address of
the Industrial Ethernet CP443-1. The module start address is available in STEP 7
in the hardware configuration.

Figure 3-6

DB270

FB270
LADDR

WORD
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3.2.2 Sequence of FB270 “SR_DIAG_400”

Overview

Figure 3-7 illustrates the sequence of FB270 “SR_DIAG_400".
Figure 3-7

| ID = connection number =0 |<—

- 0

call FC10 “AG-CNTRL" with CMD 0

| call FC10 “AG-CNTRL" with CMD 1

]

Determining the connection type and status for the display in the
connection overview

Determining the maximum number of configurable connections

]

HMI_CONN_RESET = TRUE

\Qno

call FC10 “AG_CNTRL" with CMD 2 |

¥

HMI_CONN_STOP = TRUE e

\ygnein

call FC10 “AG_CNTRL" with CMD 6 |

!

HMI_CONN_START = TRUE e

\yiTno

call FC10 “AG_CNTRL" with CMD 7

v
* Error evaluation
» Save the maximum number of configurable connections in the
instatance DB
* Prepare data for display in the details view

4

4

-

FB270 “SR_DIAG_400” encapsulates the call of FC10 “AG_CNTRL” from the
library “SIMATIC_NET_CP - CP 400 - Blocks” with various commands (CMD)
for determining:

o the connection status and connection type of SEND/RECEIVE connections

e the number of maximum configurable SEND/RECEIVE connections, as well as
for realizing various functions e.g.:

e Reset the connection (RESET)
e Start the connection (START)
e Stop the connection (STOP)
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3 2BFunction Mechanisms of this Application

3.2.3 HMI interface

The data required for the visualization is stored in the instance data block DB270 in
the following tags (see Table 3-14). These tags are integrated into WinCC flexible
and form the HMI interface. This enables displaying the data stored in the tags at
the HMI Multi Panel or the tags can be set by the HMI Panel.

Table 3-14
Address Tag Data type Description
DB270
32.0 CONN Array [0..65] Status information of all
of UDT 170 configurable SEND/RECEIVE

connections

296.0 MAX_CONNECTION Integer Maximum number of
configurable SEND/RECEIVE
connections

298.0 HMI_CONN Integer Connection number

300.0 HMI_Detail Bool Details view
activated/deactivated

300.1 HMI_CONN_STOP Bool Stop SEND/RECEIVE
connection

300.2 HMI_CONN_START Bool Start SEND/RECEIVE
connection

300.3 HMI_CONN_RESET Bool Reset SEND/RECEIVE
connection

301.0 HMI_CONN_TYPE Byte Connection type

302.0 HMI_CONN_STATUS Byte Connection status

303.0 HMI_CONN_RESERVE1 | Byte Reserve

304.0 HMI_CONN_RESERVE2 | Byte Reserve

306.0 HMI_CMD_STATUS Integer Job status

Setup of UDT 170

The relevant status information of all configured SEND/RECEIVE connections, e.g.
connection type and connection status, are stored in the instance data block
DB270 in CONN array of data type UDT 170.

Table 3-7 shows the setup of the user-defined data type UDT170.

Details view

The HMI_Detail tag of data type Bool is controlled by the HMI Multi Panel. If the
HMI_Detail tag has the value “true”, then the following status information listed in
Table 3-8 of a selected SEND/RECEIVE connection is updated for the display in
the details view and stored in the instance data block DB270.

Connection status

In HMI_CONN_STATUS tag of data type Byte the connection status of a selected
SEND/RECEIVE connection is stored for the display in the details view.

Table 3-9 shows the value range of the HMI_CONN_STATUS tag.
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Connection type

In HMI_CONN_TYPE tag of data type Byte the connection type of a selected
SEND/RECEIVE connection is stored for the display in the details view.

Table 3-10 shows the value range of the HMI_CONN_STATUS tag.

Connection number

In HMI_CONN tag of data type Integer the connection number is stored. The tag is
set via the HMI Multi Panel in connection overview of the SEND/RECEIVE
connection.

If the value of the HMI_CONN tag is larger than the determined maximum number
of configurable SEND/RECEIVE connections, the HMI_CONN tag is set to value
1(dec).

If the value of the HMI_CONN tag is smaller than 1 (dec), the HMI_CONN tag is
set to the determined maximum number of configurable SEND/RECEIVE
connections.

Job status

The HMI_CMD_STATUS tag data type integer is implemented in the details view of
SEND/RECEIVE connection. It displays the job status of the functions STOP,
START und RESET.

Table 3-11 shows an overview of the job status of functions STOP, START and
RESET and the value of the HMI_CMD_STATUS tag.

3.24 Functions

The tags of the instance data block DB270 listed in Table 3-12 are implemented in
the details view of the SEND/RECEIVE connection diagnostic and can therefore be
controlled via the HMI Multi Panel to realize different functions.

If the tags are controlled to value “true” a job for resetting, stopping or starting a
certain, selected SEND/RECEIVE connection is initiated.

Reset the connection (RESET)

If the HMI_CONN_RESET tag of the type BOOL has the value “true”, then the
FC10 “AG_CNTRL” is called with input parameter CMD=2. This resets the
connection specified at the input parameter ID via the connection number.

If the job was completed successfully or with error, then the HMI_CONN_RESET
tag is reset to value “false”.

If the job was completed with error, then there is an additional error evaluation (see
3.2.5 “Error evaluation”).

Stop the connection (STOP)

If the HMI_CONN_STOP tag of the type BOOL has the value “true”, then the FC10
“AG_CNTRL” is called with input parameter CMD=6. This stops the connection
specified at the input parameter ID via the connection number.

If the job was completed successfully or with error, then the HMI_CONN_STOP tag
is reset to value “false”.

If the job was completed with error, then there is an additional error evaluation (see
3.2.5 “Error evaluation”).
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Start the connection (START)

If the HMI_CONN_START tag of the type BOOL has the value “true”, then the
FC10 “AG_CNTRL” is called with input parameter CMD=7. This starts the
connection specified at the input parameter ID via which the connection number
has been specified and which was previously stopped with CMD=6.

If the job was completed successfully or with error, then the HMI_CONN_START
tag is reset to value “false”.

If the job was completed with error, than there is an additional error evaluation (see
3.2.5 “Error evaluation”).

3.2.5 Error evaluation

If the start, stop or reset job of the FC10 “AG_CNTRL” is transferred successfully to
the Industrial Ethernet CP then the HMI_CMD_STATUS tag is set to value 0 (dec).

If one of the jobs of FC10 “AG_CNTRL” was not successfully transferred to the
Industrial Ethernet CP and completed with error, then the value of the output
parameter STATUS is evaluated.

For the display in the details view a value is assigned to the HMI_CMD_STATUS
tag according to the value at the output parameter STATUS (see Table 3-13).
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3.3 Diagnosing S7 connections with FB171 “S7_DIAG”

Function block FB171 “S7_DIAG” is used for diagnosing the S7 connections of the
CP343-1.

FB171 is called cyclically in OB1.

When calling FB171 “S7_DIAG” a configuration of input and output parameters is
not necessary.

3.31 Sequence of FB171 “S7_DIAG”

Overview

Figure 3-8 illustrates the sequence of FB171 “S7_DIAG”.
Figure 3-8

maximum number of diagnosable S7 connections in the valid [€
value range 1 to 64(dec) <

\QTno

maximum number of diagnosable S7 connections is set to value |
64(dec)

call FC62 “C_CNTRL" |

!

Job completed successfully |

\QTno

—>| Determining the connection status

!

| HMI_Detail = TRUE

\QTno

‘ Values of the connection number and connection status are
stored in the instance data block for the display of the details
view

FB171 “S7_DIAG” encapsulates the call of function FC62 “C_CNTRL”, in order to
determine the status of S7 connections of the CP343-1 for the S7-300. If function
FC62 “C_CNTRL” is called at the control input EN_R with the value 1, the current
status of the connection addressed via the input parameter ID is determined.
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Input and output parameters of function FB62 “C_CNTRL”
Function FC62 “C_CNTRL” has the following input and output parameters.

Figure 3-9
FC62,,C_CNTRL“
BOOL EN_R RET_VAL INT
WORD ID ERROR BOOL
STATUS WORD
C_CONN BOOL
C_STATUS WORD
Table 3-15
Input parameters Data type Description
EN_R BOOL Control parameter (enable to receive)
The control parameter signals read to
receive if the input is set.
ID WORD Connection number
The connection number is contained in the
configuration.
Table 3-16
Output parameters Data type Description
RET_VAL INT Error information
ERROR BOOL Status parameters ERROR and STATUS:
STATUS WORD ¢ ERROR=0 and STATUS has the
values:

0000H: neither warning nor error
<>0000H: warning

¢ ERROR=1: error

C_CONN BOOL Status of the corresponding connection:
0: connection stopped or not started
1: connection exists

C_STATUS WORD Connection status:

W#16#0000: connection is disconnected
W#16#0001: establishment is in process
W#16#0002: connection is established

W#16#000F: connection status is not
available

W#16#00FF: connection is not configured
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Value range of the maximum number of S7 connections

In FB171 “S7_DIAG” it is checked whether the maximum number of diagnosable
S7 connections is in the valid value range 1 to 64 (dec). The maximum number of
S7 connections is stored in the instance data block of FB171 in the
Max_connection tag of data type integer.

If the maximum number of S7 connections lies outside the valid value range, then
the MAX connection tag is set to value 64(dec). The maximum number of
diagnosable S7 connections is therefore limited to 64(dec).

Determining the connection status for the display in WinCC flexible

For each connection number in the value range from 1 to 64 the function FC62
“C_CNTRL" is called and the job result of the output parameters C_STATUS and
C_CONN is evaluated.

The job result of the output parameter C_STATUS and C_CON, which contains
information on the connection status, is evaluated and structured filed in the
instance data block DB170 (see 3.2.3 “HMI interface”).

3.3.2 HMI interface

The data required for the visualization is stored in the instance data block DB171 in
the following tags (see Table 3-17). These tags are integrated into WinCC flexible
and form the HMI interface. This enables displaying the data stored in the tags at
the HMI Multi Panel or the tags can be set by the HMI Panel.

Copyright © Siemens AG 2010 All rights reserved

Table 3-17
Address Tag Data type Description
DB171
16.0 CON_ACTIVE_1 DWord Status of the S7 connections
(connection number 1-32)
20.0 CON_ACTIVE_2 DWord Status of the S7 connections
(connection number 33-64)
24.0 CONN_STATUS Array [0..65] of | Status information of all
Byte configurable S7 connections
90.0 HMI_Detail Bool Details view
activated/deactivated
91.0 HMI_CONN_STATUS Byte Connection status
92.0 HMI_CONN Int Connection number
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Structure of the CONN_STATUS tag

The value at output parameter C_STATUS of the FC62 “C_CNTRL” function is
stored for each S7 connection in the instance data block DB171. The
CONN_STATUS tag of data type Array is available for this.

The CONN_STATUS tag has the following structure:

Table 3-18
Tag Data type Value Value Description
(hex) (dec)
CONN_STATUSIO0] BYTE B#16#00 0 connection is disconnected
B#16#01 1 establishment is in process
B#16#02 2 connection is established
B#16#0F 15 connection status is not
available
B#16#FF 255 connection is not configured
CONN_STATUS[1] | BYTE B#16#00 0 connection is disconnected
B#16#01 1 establishment is in process
B#16#02 2 connection is established
B#16#0F 15 connection status is not
available
B#16#FF 255 connection is not configured
CONN_STATUSI[65] | BYTE B#16#00 0 connection is disconnected
B#16#01 1 establishment is in process
B#16#02 2 connection is established
B#16#0F 15 connection status is not
available
B#16#FF 255 connection is not configured

The status information stored in the CONN_STATUS array is implemented in
WinCC flexible in the connection overview.

Connection Diagnostics CPx43-1
V1.0, Entry ID: 42453077 37



3 2BFunction Mechanisms of this Application

Copyright © Siemens AG 2010 All rights reserved

Structure of the CONN_ACTIVE_1 und CONN_ACTIVE_1 tag

The value at output parameter C_CONN of the FC62 “C_CNTRL” is stored for
each S7 connection in the instance data block DB171. The tags CONN_ACTIVE_1
and CONN_ACTIVE_2 of data type DWord are available for this.

Table 3-19 shows the structure of DWord CONN_ACTIVE_1. The individual bits of
the DWord show the status of the configured S7 connections with the connection
numbers 1 to 32.

Table 3-19
CONN_ACTIVE_1 Value range Description
Bit 0 0 Connection with connection number 1 stopped
or not started
Connection with connection number 1 started
Bit 1 0 Connection with connection number 2 stopped
or not started
1 Connection with connection number 2 started
Bit 31 0 Connection with connection number 32 stopped
or not started
1 Connection with connection number 32 started

Table 3-20 shows the structure of DWord CONN_ACTIVE_2. The individual bits of
the DWord show the status of the configured S7 connections with the connection
numbers 33 to 64.

Table 3-20
CONN_ACTIVE_2 Value range Description
Bit 0 0 Connection with connection number 33 stopped
or not started
Connection with connection number 33 started
Bit 1 0 Connection with connection number 34 stopped
or not started
1 Connection with connection number 34 started
Bit 31 0 Connection with connection number 64 stopped
or not started
1 Connection with connection number 64 started

Details view

The HMI_Detail tag of data type Bool is controlled by the HMI Multi Panel. If the
HMI_Detail tag has the value “true”, then the following status information of the
selected S7 connection is prepared for the display in the details view and stored in
the instance data block DB171.

Table 3-21
Tag Data type Status information
HMI_CONN Int Connection number
HMI_CONN_STATUS Byte Connection status
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Connection status

In HMI_CONN_STATUS tag of data type Byte the connection status of the
selected S7 connection is stored for the display in the details view.

Table 3-22 shows the value range of the HMI_CONN_STATUS tag.

Table 3-22
Value (hex) Value Connection status
(dec)
B#16#00 0 connection is disconnected
B#16#01 1 establishment is in process
B#16#02 2 connection is established
B#16#0F 15 connection status is not available
B#16#FF 255 connection is not configured

Connection number

In HMI_CONN tag of data type Integer the connection number is stored. The tag is
set via the HMI Multi Panel in connection overview of the S7 connection.

If the value of the HMI_CONN tag is not within the valid value range 1 to 64 (dec),
then the HMI_CON tag is set to value 64(dec). This corresponds to the maximum
number of diagnosable S7 connections.
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4 Configuration and Settings

4.1 Configuring the communication connections
411 Configuring the SEND/RECEIVE connection

The following instruction shows the configuration of a SEND/RECEIVE connection
exemplary for a TCP connection:

Table 4-1
No. Action Note
1. Open NetPro in the SIMATIC Manager I/ SIMATIC Manager - [Diag - D:\Projects'BSP_FC10]
via menu Options = Configure 5P File Edt Insert PLC View | Options Window Help
. “ ) 8 B Customize. .. Ctrl+Ak+E
Network or via the “Configure ST 4| e ,
» ] 0ot
Network” button. . SIMATIC 400 Change Log »
& SIMATIC 315 [ TextLibraries L
[+ SIMATIC 319 Language for Display Devices. ..
B MP277 g Manage Multiingual Texts »
T

Sirnulate Modules
Configure Process Diagnostics

CAx Data 13

Set PGJPC Interface...

2' SeleCt the CPU Of the SIMATIC Station iiNetPro - [BSP_FC10 {Network) -- D:\Projects\BSP_FC10]
Metwork.  Edit PLC View ions  ‘Window  Hel
and select the menu Insert > New L — e ’

Connection..

The dialog box “New Connection”
appears.

=8 mg Network Objects Chrl+G HE@ 1 |§"-"

O Cri+M

SIMATIC 315 SIMATIC 319
g CF [cF cEmiERD === [CFU WPIOFIOF PRIG]CP
152 R Sl (5103 ! R ¥ ¥

Ci
: Advanci PH/DP ;. i. 5. :an
] | ‘ 2 2 |
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No. Action Note
Select “Unspecified” as the connection X
partner. o Connection Partner
If the communication partner has been = inthe -
configured in the same STEP 7 project, 5l é D.:”"e"t profect
you can select the CPU of the - gMpz??

communication partner directly.

Select the connection type “TCP
connection”.

Apply the settings with “OK”.

The properties dialog of the TCP
connection opens.

=l

o[l SIMATIC 319
o SIMATIC 400

~— All broadcast stations
we )l pdticast stations
BB In unknown project

Station: |[Unspecified)

Module |

[¥ | Dizplay properties befare inserting

Froject J E

oK sy | Cancel | Hep |

Switch to the “General Information” tab. x|
Specify whether the SIMATIC station is General Information | Addresses | Options | Overview | Stetus Infomation |
involved active or passive in Local Endpoint  Block Pasomelars
establishing the connection, i.e. activate
or deactivate the function “Active Dbt 0004 A0S0 ¥] 10—ID
connection establishment”. Name: [TCP connectior] WHEHO100 uwn‘
When using the FTP servjce via the ViaCP: [CP 5431 Advanced, PNI0 075
TCP connection, then activate the
function “Use FTP protocol”. Bode. |

(T~ Active connection establishment

[~ Use FTP protocal
¢
Cancel | Help |

Switch to the “Addresses” tab. x|
Enter the IP address of the General Information  Addresses 1Dpﬁom| Overview | Status Information |
communication partner. Pots fom 1025 iough 65535 o avaible.
Enter the local port of the SIMATIC Mokt Ak i)
station and the port of the
communication partner. Local Fiemote

IP {deck [152168.0.20 [1sz1e80d

PORT [dec} | 2002 2002

Cacel | Hep |
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o  Write passive

The operating modes Fetch or Write are
only possible if the SIMATIC station is
involved passive in establishing the
connection.

If you have already activated the
function “Use FTP protocol” in the
“General Information” tab, then the FTP
mode is set.

Apply the settings with “OK”.

No. Action Note
6. Go to the “Options” tab. x|
Select one of the following modes. General Information. || Addresses | Options | Dverview || Status Information |
e Send/Recv Local
e Fetch passive or Hode: [Send/Recy ~

Send/Recy

Fetch passive
Wi

Cancel | Help

41.2 Configuring the S7 connection

The following instruction shows the configuration of a S7 connection exemplary for
an unspecified, unilaterally configured S7 connection:

Table 4-2

No. Action

Note

1. Open NetPro in the SIMATIC Manager
via menu Options > Configure
Network or via the “Configure
Network” button.

JJSIMATIC Manager - [Diag -- D:\Projects'BSP_FC10]

5P File Edt Insert PLC View | Options Window Help

= g? =1 | ¥ By R Customize. .. Ctri+Al+E
= Access Protection »
"l SIMATIC 400 Changs Log ¢
Texk Libraries »
Language for Display Devices. ..
B MP277 Manage Multlingual Texts »

Hewi

Rur=Tirrmn

Gompare Blocks

Reference Data »

Sirnulate Modules
Configure Process Diagnostics

CAx Data L

OC YWizard

Set PGIPC Interface...

2. Select the CPU of the SIMATIC Station
and select the menu Insert =2 New
Connection...

The dialog box “New Connection”
appears.

giNetPro - [BSP_FC10 (Network) -- D:\Projects\BSP_FC10]

R Network EdR | Insert PLC View Options Window Help
=8 By & Newokobies e ||y | |\?‘

Ethernat{ 1) New Connection...  Ctri+N

SIMATIC 319
Filll S [ [5s T
H PH/DP | H H Lean
o B il H I ]
[ ] *
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No. Action

Note

3. Select “Unspecified” as the connection
partner.

If the communication partner has been
configured in the same STEP 7 project,
you can select the CPU of the
communication partner directly.

Select the connection type S7
connection.

Apply the settings with “OK”.

The properties dialog of the S7
connection opens.

Insert Mew Connection x|
— Connection Partner

=1-8] In the curent project
= 8P Diag
= MP277
=-E SIMATIC 319
= SIMATIC 400

d]
-~ Al beoadcast stations
e S0l puilticast stations
&P In unknown project

Project | E

Station: |[Unspecified)

odule [

— Connection

[Llpe: |5? connechion ﬂ

= Display properties before insertng

oK. Apply | Cancel | Hep |
4, Specify whether the SIMATIC station is x|
involved active or passive in General | S1atus Iformetion |
establishing the connection, i.e. activate L[g:u : Block Parameters
or deactivate the function “Active ge G "
connection establishment”.
Enter the IP address of the I [Send e g -
communication partner.
. “ AP 1~ Connection Path
Click the “Address Details” button. it P
End Point: S%A;:%? Ds; |Umpeu‘ﬁed
Interface: [CP 3431 Advanced. PHADIRD/S4) ] [Unspeciied =
Subnet: ﬁ\elnetm [Industiial Ethemet] |[\ndusl|i51 Ethemet]
Address: [192.168.0.20 [192168.0.39
Cancel Help
5. Enter the local TSAP of the SIMATIC x
station and the TSAP of the Local Eaitnes
communicatio_n partr.1er. End Point SHATICIIET Unspectied
Apply the settings with “OK”. e P P o A
[;';\E:ecﬁmhemce 5 = [ic] -
TSAP: 16.02 0a.02
57 Subnet D: 043C - 0007 |
Cancel Help
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4.2 Programming the communication blocks for the data
exchange
421 Programming the communication function blocks for the data

exchange via SEND/RECEIVE connections

For data exchange via the following communication connections of a S7-300
Industrial Ethernet CP you call the communication function blocks FC5
“AG_SEND” and FC6 “AG_RECV” in the S7 program.

e TCP connection with the services SEND/RECEIVE or FETCH/WRITE

e ISO-on-TCP connection with the services SEND/RECEIVE or FETCH/WRITE
e IS0 transport connection with the services SEND/RECEIVE or FETCH/WRITE
e USP connection with the SEND/RECEIVE services

The communication function blocks FC5 “AG_SEND” and FC6 “AG_RECV” are
available in the “SIMATIC_NET_CP - CP300 - Blocks” library.

For data exchange via SEND/RECEIVE connections of a S7-400 Industrial
Ethernet CP you use the communication function blocks FC50 “AG_LSEND” and
FC60 “AG_LRECV” from the “SIMATIC_NET_CP - CP 400 - Blocks” library.

On the internet the following program examples are available to you as downloads
(see \4\ and \5\).

4.2.2 Programming the communication function blocks for data exchange
via S7 connections

For data exchange via the S7 connections of a S7-300 Industrial Ethernet CP the
following communication function blocks are available to you:

e FB14 “GET” and FB15 “PUT” for unilaterally and bilaterally configured S7
connections

e FB12 “BSEND” and FB13 “BRECV"” for bilaterally configured S7 connections
e FB8 “USEND” and FB9 “URECV” for bilaterally configured S7 connections

These communication function blocks are available in the “SIMATIC_NET_CP >
CP300 > Blocks” library. Call the respective communication function blocks in the
S7 program.

For data exchange via the S7 connections of a S7-400 Industrial Ethernet CP the
following system function blocks are available to you:

e SFB14 “GET” and SFB15 “PUT” for unilaterally and bilaterally configured S7
connections

e SFB12 “BSEND” and SFB13 “BRECV” for bilaterally configured S7
connections

e SFB8 “USEND” and SFB9 “URECV” for bilaterally configured S7 connections

These system function blocks are available in the standard library at “System
Function Blocks - Blocks”.

On the internet the following program examples are available to you as downloads
(see \6\, \7\ and \8\).
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4.2.3 Programming the communication function blocks for data transfer
with FTP
The following functions are available to you for data transfer with FTP:
Table 4-3
Function Symbolic name Description
FC40 FTP_CONNECT Establishment of an FTP connection from client
to server
FC41 FTP_STORE Transfer of a DB from client to server
FC42 FTP_RETRIEVE Transfer of a file from server to client
FC43 FTP_DELETE Deleting a file on the server
FC44 FTP_QUIT Stopping a connection which has been started
via ID

For the following module types the function block FB40 “FTP_CMD” is additionally
available to you for data transfer with FTP:

e (CP343-1 Advanced as of 6ES7343-1GX30-0XEO0
e (CP443-1 Advanced as of 6ES7443-1GX20-0XEO0

With FB40 “FTP_CMD” you can establish FTP connections and transfer files from
and to an FTP server.

Detailed information on the function blocks and on the functions for data transfer
with FTP is available in the manual “Functions (FC) and Function Blocks (FB) for
SIMATIC NET S7-CP Programming Manual” (see \16\).
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5 Installation
5.1 Installation of the hardware
Overview

The figure below shows the hardware setup of the application.

Figure 5-1
S$7-300 Station A S§7-300 Station B
0 1) ; g 1 ; Partner
a <t B <t .
[ ™ station
o o
(&) o
192.168.0.20 SCALANCE X208 192.168.0.11
r——
o
SIMATIC Field PG Il MP277 8“ Touch
[ﬁlﬂ
d

192.168.0.150 192.168.0.18

The following table gives you an overview of the IP addresses used.

Table 5-1
Device IP address Subnet mask
SIMATIC Field PG 192.168.0.150 255.255.255.0
MP277 8” Touch 192.168.0.18 255.255.255.0
CP343-1 (S7-Station A) 192.168.0.20 255.255.255.0
CP343-1 (S7-Station B) 192.168.0.11 255.255.255.0
SCALANCE X208 192.168.0.100 255.255.255.0
Note It is also important to read the descriptions, manuals and any delivery

information supplied with the products.
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Installation of the multi panel MP277 8 Touch

Assign the IP address to the multi panel MP277 8” Touch according to the

configuration (see Figure 5-1).
Table 5-2

Action

Screenshot

On the operator panel MP277 8”
Touch at Control Panel >
Network and Dial-up
Connections = LAN90001 you
set the IP address 192.168.0.18 and
the subnet mask 255.255.255.0.

'SMC LAN91C111 Ethernet’ Settings o] |
IP Address INa'ns Servers | Ethernet Parameters |

An IP address can be
automnatically assigned to this
computer. If your network
does not automatically assign
IP addresses, ask your network
administrator for an address,

192.168.0 .18
and thon fune i e the cnacs 295 .295.235 0
SN INen TYpe L i NS spats

plruvlded. Default Gateway: . ' .

(C) Obtain an IP address via DHCP

Installation of the S7 station A

Assign the IP address to the CP343-1 according to the configuration (see Figure

5-1).
Table 5-3
Action Screenshot
Open the SIMATIC Manager via the
Windows Start menu =
SIMATIC - SIMATIC Manager.
In the SIMATIC Manger via the x|
menu PLC > Edit Ethernet ~Ethemet node
. Nodes accessible online
Node... you assign the IP address
MAC address: 00-0E-8C-A4-24-98

192.168.0.20 and the subnet mask
255.255.255.0.

Set IP configuration
* se |P parameters

Gateway
IP address:
L L2 192168.0.20 | Dig oot Uiem e
Subnet mask: 265,255.255.0 " Use router
" Dbtain IP address from 3 DHCP server
Identified by
& Client D € MAL addre € Deyice name
ChentiD: [
Assign IP Configuration
Assign device name
Device name: Do Bstion Name
- Reset to factory setting
Beset
Close Help
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Installation of S7 station B

Assign the IP address to the CP343-1 according to the configuration (see Figure

5-1).
Table 5-4
Action Screenshot
Open the SIMATIC Manager via the
Windows Start menu =
SIMATIC - SIMATIC Manager.
In the SIMATIC Manger via the x|
menu PLC - Edit Ethernet Ethernet node N o
Node... you assign the IP address gkt
MAC address: 08-00-06-3C-44-0B

192.168.0.11 and the subnet mask
255.255.255.0.

- SetIP configuration

% Use P parameters

Gateway

[Flookess 192168.0.11 (% Do not use router
Subnet mask;: 255,255.255.0

™ Use iouter
I

" Obtain IP address from a DHCP server

 |dentified by
& Client D € MEC sddre € Device name
ChegtiD: |

Agsign IP Configuration
- Agsign device name —

Device name: cp-343-1-ean Assign Name:

~ Resat to factory sefting

Beset
Close Help
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5.2 Installing the software

Keep the following order when installing the configuration software on the SIMATIC
Field PG:

e Install STEP 7 V5.4 SP5 or higher
¢ Install WinCC flexible 2008 SP1.

Note In the manual of STEP 7 and WinCC flexible you find further information on
installing the configuration software (see \10\ and \13\).

5.3 Application software installation

The application software is a STEP 7 project which contains the complete
hardware configuration of multi panel MP277 8” Touch and S7-300 station.

In addition to the hardware configuration of MP277 8” Touch and the S7-300
station, the WinCC flexible project for the multi panel MP277 8” Touch as well as
the S7 program for the S7-300 station are integrated in the STEP 7 project.

The STEP 7 project can be downloaded from the internet as a ZIP file.

Unzip the file “42453077_diagnostic_v10.zip” into a separate directory. The STEP
7 project is then automatically unzipped with all respective subdirectories.
Subsequently, you can open and edit the extracted STEP 7 project with the
SIMATIC Manager.
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6 Starting up the Application

6.1 Preparation

Assign the IP address to the network card of the SIMATIC Field PG according to
the configuration (see Figure 5-1).

Table 6-1
Action Screenshot
Open the Properties dialog of the Internet Protocol {TCP/IP) Properties el B
Local Area Network (LAN) in the Genesal |
Network Connections of Windows.
“ou can get IP settings assigned automatically if wour network. supports
Enter the IP address thiz capability. Dtherwise. you need to ask your network. administrator for
192.168.0.150 and the subnet the appropriate P settings.
mask 255.255.255.0.
" Obtain an IP addiess automatically
= Use the following IP address;
P address: [152 162 0 180 ]
Subnet mask: |255.255.255. 0
Default gateway: | i ;
€ (btain DNG senver address automatically
(% Use the following DNS server addresses:
Frefened DMS server I ; . ;
Altemate DMS server I 2 ¢ 3
Advanced... I
oK | Cancel ‘

6.2 Commissioning the multi panel MP277 8” Touch
6.2.1 Hardware configuration

In the hardware configuration of the multi panel MP277 8” Touch you enter the IP
address, already set on the multi panel, for the Industrial Ethernet interface (see
chapter 5.1 “Installation of the hardware”).
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Table 6-2
Action Screenshot
Open the Properties dialog of the =l
Industrial Ethernet interface and General | Diagnostics |
click the “Properties...” button. Shott Desciiption: ~ HMIIE
SIMATIC HMI IE ;l
1]
Order No.: IEZCP
Mame: Hil IE]
Intefface————————
Type: Ethemet
Address: 192168018
Metworked: Yes
Comment:
=l
=

In the dialog “Properties —
Ethernet interface HMI IE” >
“Parameters” tab you enter the IP
address and Subnet mask which
you have already set on the multi
panel.

In Subnet you select the Ethernet
subnet to which you wish to
assign the HMI IE interface.

If an Ethernet subnet does not yet
exist, you click the “New...” button
to create a new Ethernet subnet.

Properties - Ethernet interface HMI IE (RO/S5)

General  Farameters I

Subnet mask: 255.255.255.0

" Use router

‘ -~ Gateway
[_F‘lﬁftﬂ- 192168.018 ] ' Do not uss router

fddress:  |152162.0.18
Subnet:
- rat networked - New... |
Properties... |
Delete |
Caesl_| it

Save and compile the hardware
configuration of the multi panel
MP277 8” Touch.

Ff HW Confiig - [MP277 {Configuration) -- BSP_FC10]
ﬁstetiun Edit Insert PLC ‘iew Oplions Window Help

DEe8(%) &) - e da Do 8w

N
Save and compile

WinCC fexible AT
IF1B MPI/DP

HiI IE

| on] || ra]=
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6.2.2 Loading WinCC flexible Runtime

When loading the WinCC flexible Runtime onto the multi panel MP277 8” Touch,
please proceed according to the following instruction:

Table 6-3

No. Action

Screenshot

1 In the SIMATIC Manager under
the object HMI Station “MP277”
you right-click the entry “WinCC
flexible RT” and select the “Open
Object” item.

The WinCC flexible project of the
MP277 8” Touch opens.

_. SIMATIC Manager - [BSP_FC10 -- D:\Projects\BSP_FC10]

BEpFle Edt Insert PLC View Options Window Help

O 2947 & 20 dallo %)% & &

= &9 BSP_FC10

il SIMATIC 315 ZFTBidsr
SIMATIC 319 . B Kosmurikalion
-8 SIMATIC PC-Station % Meldungen
- g it £ Rezepturen
3R] /i CC flexible B
Open Object Crrl4+ak+0
Cut Chrl 4%
Copy Chrl+C | [ P—
Paste CErl+Y hung... -
Delete Del paen
Rename F2
Object Properties... Alk+Return

2 In WinCC flexible you click the
“Select transfer settings and start
transfer to the device” button.
The dialog “Select devices for
transfer” appears.

Project Edit View Insert Format Faceplates Options Window Help

o New < b W - . v oe%. (3. .
_ |German [Germany] | :] I j i B !

leas Projekt
E-puee MP277(MP 277 8" Touch)
E-555 Screens

| SIEMENS

4 4dd Screen Select transfer settings and
E ;?“g;: start transfer to the device
57_Ubersich
g SH‘_D;;'C t Connection diagnosti
1 SR_Obessicht SRR el e
1 Start |
3 Select the “Ethernet” mode and B e
enter the IP address 192.168.0.18 e [
of the MP277 8” Touch. = oo =) ek
Click the “Transfer” button to S oo —
transfer the WinCC flexible izl ) F e
Runtime to the MP277 8” Touch.
l Transfer | Apply Cancel Py
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6.3

Commissioning the S7 station A

6.3.1 Loading the hardware configuration
In the hardware configuration of S7 station A you enter the already assigned IP
address for the CP343-1 (see chapter “5.1” “Installation of the hardware”).
Table 6-4
No. Action Screenshot
1. Open the Properties dialog of Properties - PN-I0 (R0/54.3) x|
the PN-10 interface of the General | Addresses | IP Configuration | PROFINET | Synchiorization | Media Redundancy |
CP343-1 and click the .
. . Shoit description: PH-I0
“Properties...” button.
Device name: |F‘N-IIJ
¥ Support device repl without exchangeable medium
o Inerface
Type: Ethemet
Device number: 0
Address: 192.168.0.20
——
tmrnent: .
=
|
Col | top
2 In the “Properties - Ethernet Propertics Ethernet inerfoce PNIORO/549) x|
interface PN-10” dialog select General  Parametes |
the “Parameters” tab and enter e ——
IP address and subnet mask L s e ek
which you have already MAC addiess: |
assigned to the CP343-1.
Acknowledge the entry with o
“OK”. [lPadcka;s: J192.168.020 ] gnomm e
Subnet mask: I2‘35.255.255.D -
" Use router
Address:  [192.168.0.20
Subnet:
- nok networked - Hew... |
Froperties. .
Delete
Cocd | Heb |
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No. Action

Screenshot

configuration of the S7-300
station and load it onto your
CPU.

3. Save and compile the hardware

P HW Config - [STMATIC 315 (Configuration) — BSP_FC10]

Bl Station Edit Insert PLC Wiew Options Window Help

D8R8 be (kDo %2

1 PS 07108 N SN
2 CPU 315-2DP "\ o~
X2 e Save and compile download
3 -
4 [ CP 343-1 Advanced
x|l Gar
KT PT Poxt 7
M2 PO
X2 PT Fort 7
M2 A2 Powf 2
5 CP 3431
6.3.2 Loading the communication connections
When loading the communication connections proceed as follows:
Table 6-5
No. Action Screenshot
1. Open NetPro in the SIMATIC Manager | | e (e R a0 e S T ]
via menu Options > Configure @Fﬂe Edit Insert PLC ‘iew | Options Window Help
Network or via the “Configure D@ |8 4 BB e on SR
Network” button. = Ot
= SIMATIC 400 i) 1
- SIMATIC 315 [l  TextLibraries 4
=-Fl SIMATIC 219 Language For Display Devices...
B MP277 O] Manage Multiingual Texts »
& e
%ﬂ Run=Time Properties...
Reference Data ,
Define Global Data
Simulate Modules
Configure Process Diagnostics
Chx Data ]
OC Wizard
Set PGIPC Interface...
2. Select the CPU of the SIMATIC Station | SEESEEFEEEEiss
“ ” -4 i I B & = ALY
SIMATIC 315" == 1
The connection table shows you the Ve
configured S7 and SEND/RECEIVE -
connections.
SIMATIC 315 ‘S\MATIC 319 MP277
i E‘"’ :,; OSTIFIHD © g i
y T
0001 A0SO 0001 ADSD 'SMATIC 319 / CPU 319-3 PNDP No Ethernet(1) ]
o o 2 =i
i fioe B =
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No. Action Screenshot
3_ SeleCt the S|MAT|C 300 Station ;%Netpru - [BSP_FC10 (Network) -- D:\Projects\BSP_FC10]
“SIMATIC 315”. Then save and compile .",“N,”;‘E"f, "‘:’L”,E]""‘: e
the configuration and load it to the CPU. | (=== == 8 & = = (B = ° b :
E download
i > Save and compile
SIMATIC 319
&) |-mvi ;Fgg MPIOP | OF iPN.lD 5:3‘1
PHN/DP - E. iar\
2
6.3.3 Calling and configuring the function blocks FB170 “SR_DIAG” and
FB171 “S7_DIAG”, and loading the user program
In the user program of the CPU315-2DP you call the function blocks FB170
“SR_DIAG” and FB171 “S7_DIAG”.
Table 6-6
Action Screenshot

1. E)all the fur]ction blocks ‘I‘=B170 ) CALL "SE DIAG® , "iDE_ SR
_SR_DIAG and FB171 “S7_DIAG LADDE: =WEL16$100
in OB1.

At the input parameter LADDR of CALL "S7 DIAG® , "iDB §7°
the FB170 “SR_DIAG” you enter - -
the module start address of the

Industrial Ethernet CP.

2. The module start address is Xl
available in the hardware Useis | Symbols |  DNSParameters | FIP | Disgrostics |
configuration_ Genersl ~ Addresses [ Options | Time-of-Day Synchionization | P Access Protection
In the Properties dialog of the Inputs
Industrial Ethernet CP select the - =B i
“Addresses” tab. Here you find the [Em = ] bt 18 Sl
module start address 256pgc =
100HEX. -

~ Outputs -
Start [2%6 "  Lengh 16 I~ Sustern defaut
Cancel Help |

3. After you have called and
configured the function blocks in
OB1 you load the user program to
the CPU315-2DP.
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6.4 Commissioning the S7 station B

6.4.1 Loading the hardware configuration

Copyright © Siemens AG 2010 All rights reserved

In the hardware configuration of S7 station B you enter the already assigned IP
address for the CP343-1 (see chapter “5.1” “Installation of the hardware”).

Table 6-7
Action Screenshot
1. Open the Properties dialog of x|
the CP343-1 and click the Tineof D/ Sprrimriaalionti] H011P Corrdion 00| (0 PROFRIETANN | I Diagrticsi|
“Properties...” button. General | Addesses | PotPazmeters | Options |

Shost Description: CP 3431 Lean
57 CP for Industrial Ethemet TCP/IP with SEND/RECEIVE and =
FETCHAWRITE interface, PROFINET 10 device, 2-port switch, long

data, SMMP. UDP, TCP., 57 communication (server], routing. module
replacement without PG, 10/100 Mbps, inttialization over LAN, IP ;l

Order Mo/ fimware BGKY 343-1CX10-0<E0 / V2.0

HName:
- Interfar
Type: Ethemet
Address: 192.168.0.11
Newket s
LComment:
=
Cocel | Heb

2. In the “Properties - Ethernet
interface CP343-1 Lean” dialog
select the “Parameters” tab and
enter IP address and subnet
mask which you have already
assigned to the CP343-1.
Acknowledge the entry with
“OK”.

Properties - Ethernet interface CP 343-1 Lean (R0/54) x|

General  Parameters |

Gateway
|P address: E 111 7 Do oo
Subnet mask: |255.255.255.0
 Use router
Address:

192.168.0.11

Subnet;
--- not networked --- Hew...
Froperties... I
Delete
Cancel | Help 1
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Action Screenshot
3. SEVCE NNV IIERGENEIGIEICENE 12 Hw Config - [SIMATIC 319 (Configuration) - BSP_FC10]
configuration of the S7-300 @l Station Edit Insert PLC View Options Window Help
station and load it onto your ~ T
CPU. JDEE*“IE&IIQII%EI[&IH (Ghll=NE--40
1 PS 307 104 N
2 CPU 319-3 PN/DP =
X7 MPADP Save and compile download
x2 oP
P P07
X2PT Poit T
3
4 [JECP3431Lean
5
6.4.2 Loading the communication connections
When loading the communication connections proceed as follows:
Table 6-8
No. Action Screenshot
1. Open NetPro in the SIMATIC Manager QSIMAI]E Manager - [Diag -- D:\Projects‘\BSP_FC10]
via menu Options = Configure Ep Fie Edt Insert PLC View |Options Window Help
Network or via the “Configure Customize. . CHtHAKEE
Access Protection 3
Network” button. Change Log »
Texk Libraries »
Language for Display Devices. ..
Manage Multiingual Texts 3
Re o
Run-Time Properties, ..
Compare Blotks,
Reference Data »
Simulate Modules
Configure Process Diagnostics
Chx Data 3
Set PGJPC Interface. ..
2. Select the CPU of the SIMATIC Station | B e e ar e e i e
“SIMATIC 319". ﬁ: 'i'\é Rl B TS DE N -
The connection table shows you the — Y
configured S7 and SEND/RECEIVE -
connections.
SIMATIC 319 MP277
- 2 1
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6 5BStarting up the Application

No. Action Screenshot
3_ Select the S|MAT|C 300 station NetPro-[Diq (Nekwurk)--D"m,PrniEts"‘.‘BEPFEII]]
. Metwork Edit Insert PLC View Options Window Help
“SIMATIC 319”. Then save and compile | (==& Wa ne @ad oo Dol
the configuration and load it to the CPU. Ethernet T 1
ndustrial Etherna download
: :E}' I Save jand compile
6.4.3 Loading the user program

Load the user program to the CPU 319-3PN/DP.
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7 Operating the Application

71 Overview

The status information of the S7 connections and SEND/RECEIVE connections,
which are configured for the CP343-1 in S7-300 station A, are displayed in WinCC
flexible Runtime on the multi panel MP277 8” Touch.

Figure 7-1
S$7-300 Station A S§7-300 Station B

Partner
station

SCALANCE X208

MP277 8 Touch
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Table 7-1

If you start WinCC flexible Runtime on the HMI Multi Panel, the start screen will be

display.

No.

Action

Screenshot

1.

The start screen of WinCC flexible

Runtime, which runs on the multi

panel MP277 8” Touch, has three

buttons:

1. EXIT, to exit WinCC flexible
Runtime

2. Diagnostic SEND/RECEIVE
connection, to open the
connection view of the
SEND/RECEIVE connection

3. Diagnostic SEND/RECEIVE
connection, to open the
connection overview of the S7
connection

SIEMENS

Connection diagnostic for CPx43-1

EXIT

Diagnostic
S7 connection

7.2 Connection overview of the SEND/RECEIVE
connections
The connection overview displays the status of all possible SEND/RECEIVE
connections of the Industrial Ethernet CP. This enables a fast diagnostic of the
configured SEND/RECEIVE connection.
Table 7-2
No. Action Screenshot

1.

In the start screen you click on the
“Diagnostic SEND/RECEIVE
connection” button to open the
connection overview of the
SEND/RECEIVE connections.

SIEMENS

Connection diagnostic for CPx43-1

EXIT

Connection Diagnostics CPx43-1
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No.

Action

Screenshot

In the connection overview of the
SEND/RECEIVE connections the
connection number and the
connection status determined in the
S7 program for all possible
SEND/RECEIVE connections are
visualized via buttons.

The number of displayed buttons is
determined dynamically. It depends
on the maximum number of
configurable SEND/RECEIVE
connections. The maximum number
of configurable SEND/RECEIVE
connections is determined in the S7
program.

SIEMENS

Overview

SEND/RECEIVE connection

| | | s | e |2 |
ol o] uf 2| | | 5| ]|

Click on the “back” button to quit the
connection overview of the
SEND/RECEIVE connections and
return to the start screen.

SIEMENS

Overview

SEND/RECEIVE connection

S S N I |
o | o] uf | s 1] 5] 1|

Connection status

The connection status of the SEND/RECEIVE connections determined in the S7
program is stored in the instance data block DB170 in the CONN array and
represented via the color of the button.

The following tags of the CONN array are assigned to the buttons with connection
numbers. The buttons are displayed in colors which depend on the value of these

tags.
Table 7-3

Button Tag of the CONN array Value

(dec)

1 CONN[1].CONN_STATUS

Color

Connection status

connection is disconnected

establishment is in process

disconnection is in process

connection is established

unknown

unknown

unknown

Njo|lg|h|lW|INI~|O

unknown
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Button Tag of the CONN array Value | Color Connection status

(dec)

2 CONN[2].CONN_STATUS

connection is disconnected

establishment is in process

disconnection is in process

connection is established

unknown

unknown

unknown

unknown

64 CONN[64].CONN_STATUS

connection is disconnected

establishment is in process

disconnection is in process

connection is established

unknown

unknown

unknown

N|oOojlalh|W|IN|—~|O N[oja|hA|W|IN|[~]O

unknown

7.3 Connection overview of the S7 connections
The connection overview displays the status of all possible S7 connections of the
Industrial Ethernet CP. This enables a fast diagnostic of the configured S7
connection.
Table 7-4
No. Action Screenshot

In the start screen you click on the
“Diagnostic S7 connection” button to
open the connection overview of the
S7 connections.

SIEMENS

Connection diagnostic for CPx43-1
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No.

Action

Screenshot

In the connection overview of the S7
connections the connection number
and the connection status
determined in the S7 program for all
possible S7 connections are
visualized via buttons.

The number of displayed buttons is
determined dynamically. It depends
on the maximum number of
configurable S7 connections. The
maximum number of configurable S7
connections is determined in the S7
program.

SIEMENS

Overview
S7 connection

| o (] | s | e | 7 | s |
o f o ul 2| | ]| 5] ]

Click on the “back” button to quit the
connection overview of the S7
connections and return to the start
screen.

SIEMENS

Overview
S7 connection

| e (] | s | o | 7 | e |
o | o] uf | s 1] 5] ]

Connection status

The connection status of the S7 connections determined in the S7 program is
stored in the instance data block DB171 in the CONN_STATUS array and
represented via the color of the button.

The following tags are assigned to the buttons with connection numbers. The
buttons are displayed in colors which depend on the value of these tags.

Table 7-5

Button Tag

Connection status

1 CONN_STATUS[1]

connection is disconnected

establishment is in process

connection is established

connection status is not
available

255 connection is not configured

2 CONN_STATUS[2]

0 connection is disconnected

1 establishment is in process

2 connection is established

15 connection status is not
available

Connection Diagnostics CPx43-1
V1.0, Entry ID: 42453077

63




Copyright © Siemens AG 2010 All rights reserved

7 6BOperating the Application

Button Tag Value | Color Connection status
(dec)
255 connection is not configured
64 CONN_STATUSI[64] | O connection is disconnected
1 establishment is in process
2 connection is established
15 connection status is not
available
255 connection is not configured
7.4 Details view of the SEND / RECEIVE connection
diagnostic
The details view shows the status information of the certain selected
SEND/RECEIVE connection.
Table 7-6
No. Action Screenshot
4. In the connection overview you click SIEMENS
the button of a SEND/RECEIVE
connection to open its details view e
for the connection diagnostics. HE RIS Gty
The HMI_CONN tag is set to the (=) e s | e |- | [
value displayed on the button. This o w] uf e | u] s ]
value corresponds to the connection
number of the SEND/RECEIVE
connection.
The HMI_Detail tag of data type Bool
is set to the value “true”.
5. The details view of the SIEMENS

SEND/RECEIVE connection
diagnostic displays the following
status information of the certain
selected connection:

e  Connection number
e Connection type
e  Connection status

Details
SEND/RECEIVE connection

connection number connection type

[SEND/RECEIVE connection

connection status

connection is established
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No.

Action

Screenshot

Click the arrow buttons to go to the
details view of the previous or
subsequent SEND/RECEIVE
connection.

SIEMENS

Details

SEND/RECEIVE connection
connection number connection type
|SEND/RECEIVE connection

Click on the “back” button to quit the
details view of the SEND/RECEIVE
connection diagnostic and return to
the overview of the SEND/RECEIVE
connections.

The HMI_CMD_STATUS tag is set to
the value 0 and the HMI_Detail tag is
reset to “false”.

SIEMENS

Details
SEND/RECEIVE connection
connection number connection type
ISEND/RECEIVE connection
o]

7.41

Visualizing the status information

To display the status information in WinCC flexible Runtime the following tags of

the instance data block DB170 are linked with WinCC flexible basic objects in the

details view.
Table 7-7

WinCC flexible
basic object

Tag

Data type

Description

I/0 field

HMI_CONN

INT

Connection number

Symbolic
I/O field

HMI_CONN_TYPE

BYTE

Connection type

Symbolic
I/O field

HMI:CONN_STATUS

BYTE

Connection status

Connection number

The connection number is visualized via the HMI_CONN tag. The value of the
HMI_CONN tag is displayed in an 1/O field.

The background color of the 1/O field depends on the value of the
HMI_CONN_STATUS tag, i.e. the background color of the I/O filed displays the
connection status of the selected SEND/RECEIVE connection.
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Table 7-8

Value of the Connection status Background color
HMI_CONN_STATUS (dec) 1/0 field

tag

establishment is in process

disconnection is in process

connection is established

unknown

unknown

unknown

N[fojlol~hA[lWIND|~]|O

unknown

Connection status

The connection status is visualized via the HMI_CONN_STATUS tag and
displayed as text in a symbolic I/O field. The text to display the connection status is
stored in the text list “SR_Connection_Status”. Depending on the value of the
HMI_CONN_STATUS tag the respective text is displayed.

Copyright © Siemens AG 2010 All rights reserved

Table 7-9
Value of the Connection status Text list
HMI_CONN_STATUS (dec) SR_Connection_Status
tag
0 connection is disconnected | connection is disconnected
1 establishment is in process | establishment is in process
2 disconnection is in process | disconnection is in process
3 connection is established connection is established
4 unknown unknown
5 unknown unknown
6 unknown unknown
7 unknown unknown

Connection type

The connection type is visualized via the HMI_CONN_TYPE tag and displayed as
text in a symbolic I/O field. The text to display the connection type is stored in the
text list “SR_Connection_Type”. Depending on the value of the
HMI_CONN_STATUS tag the respective text is displayed.

Table 7-10

Value of the Connection type Text list
HMI_CONN_Type (dec) tag SR_Connection_Type
0 unknown connection type is unknown
1 SEND/RECEIVE SEND/RECEIVE connection
connection
2 FETCH connection FETCH connection
3 - not possible
4 WRITE connection WRITE connection
5 - not possible
6 - not possible
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Value of the Connection type Text list
HMI_CONN_Type (dec) tag SR_Connection_Type
7 - not possible

8 undefined, undefined connection type

e.g. FTP connection
or e-mail connection

9 - not possible
10 - not possible
11 - not possible
12 - not possible
13 - not possible
14 - not possible
15 - not possible

7.4.2 Functions

In the details view of the SEND/RECEIVE connection diagnostic the following
functions are available to the user:

e RESET (reset the connection)
e STOP (stop the connection)
e START (start the connection)

These functions are implemented in FB170 “SR_DIAG”. In WinCC flexible Runtime
you can control these functions in the details view of the SEND/RECEIVE
connection diagnostic via buttons (see Table 7-11).
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Table 7-11

Button

Action

Comment

Reset the connection

RESET

Click on the “RESET” button to reset the
SEND/RECEIVE connection selected in
the details view, i.e. the connection is
automatically stopped and restarted via
the S7 program.

When the job has been completed, you
can reset the same connection or a
different connection again by clicking the
“RESET” button.

The HMI_CONN_RESET tag of data type
BOOL is set to the value “true”.

The FC10 “AG_CNTRL” is called with the
input parameter CMD=2 and the connection
number of the selected SEND/RECEIVE
connection is assigned to the input
parameter ID.

Changes of the connection status are
displayed in the details view.

Stop the connection

STOP

Click on the “STOP” button to
automatically stop the SEND/RECEIVE
connection selected in the details view
via the S7 program.

As soon as the connection is stopped
you click the “START” button to restart it.

The HMI_CONN_STOP tag of data type
BOOL is set to the value “true”.

The FC10 “AG_CNTRL” is called with the
input parameter CMD=6 and the connection
number of the selected connection is
assigned to the input parameter ID.
Changes of the connection status are
displayed in the details view.

Stop the connection

START | Click on the “START” button to The HMI_CONN_START tag of data type
automatically start the SEND/RECEIVE BOOL is set to the value “true”.
connection selected in the details view The FC10 “AG CNTRL” is called with the
via the S7 program. input parameter CMD=7 and the connection
The requirement is that the connection number of the selected connection is
has previously been stopped via the assigned to the input parameter ID.
STOP” button hence with CMD=6. Changes of the connection status are

displayed in the details view.
743 Job status

The job status of FC10 “AG_CNTRL” for realizing the above functions is visualized
via the HMI_CMD_STATUS tag and displayed in a symbolic I/O field as text. The
symbolic I/O field is only visible if the job status has the value <> 0. The text to
display the job status is stored in the text list “CMD_ERROR”. Depending on the
value of the HMI_CMD_STATUS tag the respective text is displayed.

Table 7-12
Value of the Job status Text list CMD_ERROR
HMI_CMD_STATUS (dec)
tag
0 job completed successfully | 0: request is completed
successfully
1 function not available 1: function not available
2 command isn’t allowed 2: command isn’t allowed
9 general error 9: general failure

If the HMI_CMD_STATUS tag has the value 0, then the symbolic 1/O field for

display of the job status is hidden.
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7.5 Details view of the S7 connection diagnostic
The details view shows the status information of the certain selected S7
connection.

Table 7-13

No. Action Screenshot
1. In the connection overview you click SIEMENS
the button of an S7 connection to
open its details view for the Oveview
connection diagnostics.
The HMI_CONN tag is set to the | (= (] s | o | 7 | s |
value displayed on the button. This o | w0 | u| 2| n| 1| 5| ]

value corresponds to the connection
number of the S7 connection.

The HMI_Detail tag of data type Bool
is set to the value “true”.

2. The details view of the S7 connection SIEMENS
diagnostic displays the following

status informatior) of a certain
selected connection: B/ GIIIZED

e  Connection number
e  Connection status

3. Click on the “back” button to quit the SIEMENS
details view of the S7 connection
diagnostic and return to the overview et

of the S7 connections.
The HMI_Detail tag is set to the
value “false”.
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No. Action Screenshot

4. Click the arrow buttons to go to the SIEMENS
details view of the previous or
subsequent S7 connection.

5. Click on the “back” button to quit the SIEMENS
details view of the S7 connection
diagnostic and return to the overview

Details

of the S7 connections. =
The HMI_Detail tag is set to the
value “false”.

7.51 Visualizing the status information

To display the status information in WinCC flexible Runtime the following tags of
the instance data block DB171 are linked with WinCC flexible basic objects in the
details view.

Table 7-14

WinCC flexible Tag Data type Description
basic object

I/O field HMI_CONN INT Connection number

Symbolic HMI:CONN_STATUS | BYTE Connection status
I/O field

Connection number

The connection number is visualized via the HMI_CONN tag. The value of the
HMI_CONN tag is displayed in an 1/O field.

The background color of the 1/O field depends on the value of the
HMI_CONN_STATUS tag, i.e. the background color of the I/O filed displays the
connection status of the selected S7 connection.
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Table 7-15
Value of the Connection status Background color
HMI_CONN_STATUS (dec) /O field
tag
0 connection is disconnected _
1 establishment is in process
2 connection is established
15 connection status is not
available
255 connection is not configured

Connection status

The connection status is visualized via the HMI_CONN_STATUS tag and
displayed as text in a symbolic I/O field. The text to display the connection status is
stored in the text list “S7_Connection_Status”. Depending on the value of the
HMI_CONN_STATUS tag the respective text is displayed.

Table 7-16
Value of the Connection status Text list
HMI_CONN_STATUS (dec) S7_Connection_Status
tag
0 connection is disconnected connection is disconnected
1 establishment is in process establishment is in process
2 connection is established connection is established
15 connection status is not connection status is not
available available
255 connection is not configured | connection is not

configured
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8 Links & Literature

8.1 Internet Links

The following list is by no means complete and only provides a selection of
appropriate sources.

Table 8-1
Topic Title

1\ Manual MP277 http://support.automation.siemens.com/WWW/view/en/23337820

\2\ FC10 “AG_CNTRL” | http://support.automation.siemens.com/WW/view/en/22637440

\3\ FC62 “C_CNTRL” http://support.automation.siemens.com/WW/view/en/1214574

\4\ FC5 “AG_SEND”/ http://support.automation.siemens.com/WW/view/en/17853532
FC6 “AG_RECV”

\5\ FC50 “AG_LSEND”/ | http://support.automation.siemens.com/WW/view/en/24693800
FC60 “AG_LRECV”

\6\ FB14 “GET"/ http://support.automation.siemens.com/WW/view/en/22792404
FB15 “PUT”

\7\ SFB14 “GET"/ http://support.automation.siemens.com/WW/view/en/23378099
SFB15 “PUT”

\8\ FB12 “BSEND”/ http://support.automation.siemens.com/WW/view/en/22789990
FB13 “BRCV”

\9\ FTP http://support.automation.siemens.com/WW/view/en/30374198

\10\ | WinCC flexible 2008 | http://support.automation.siemens.com/WW/view/en/18796010

\11\ | WinCC flexible 2008 | http://support.automation.siemens.com/WW/view/en/18797552
Communication
Part1

\12\ | WinCC flexible 2008 | http://support.automation.siemens.com/WW/view/en/18797249
Communication
Part2

\13\ | STEP7 V5.4 http://support.automation.siemens.com/WW/view/en/18652511
First Steps

\14\ | STEP 7V5.4 http://support.automation.siemens.com/WW/view/en/18652056
Programming

\15\ | Configuring http://support.automation.siemens.com/WW/view/en/18652631
STEP 7 V5.4
Hardware and
Connections

\16\ | FC and FB for http://support.automation.siemens.com/WW/view/en/30564821
S7-CPs

\17\ | WinCC flexible http://support.automation.siemens.com/WW/view/en/18795593
Runtime
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Table 9-1
Version Date Changes
V1.0 29.06.2010 First issue
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